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Kurzweil 3000  for Windows 

Getting Started 
Kurzweil 3000 Products 
 

Kurzweil 3000 Web License Subscription  

 
A yearly subscription to licenses that includes several components working together to support students wherever they are 
and on whatever device they are using. 

One Login to Access Everything 

  Kurzweil 3000 for Windows and Macintosh Installed Application 
• Install on your Windows or Mac desktop or laptop 

 

  Kurzweil 3000 for Web Browsers - http://www.Kurzweil3000.com/ 
• Access from any web browser connected to the internet 

 

  Kurzweil 3000 iPad App 
 

  Kurzweil 3000 Universal Library 
• Store your k3000 documents here 
• Share between students and teachers 
• Access from the Installed Application, Web App and iPad app for access anywhere anytime you are connected to the 

internet. 
 

    Kurzweil 3000 Read the Web extension 
• Add to Chrome or Firefox web browsers for Text to Speech (TTS) access to content on the fly 

 

Kurzweil 3000 Network 
Concurrent licenses shared across a LAN (local area network)  
Includes Kurzweil 3000 for Windows and Macintosh Installed Client ONLY 
Kurzweil 3000 Read the Web extension  

• Add to Chrome or Firefox web browsers for TTS access to content on the fly 

Kurzweil 3000 Standalone 

Individual licenses  
Includes Kurzweil 3000 for Windows and Macintosh Installed Client ONLY 
Kurzweil 3000 Read the Web extension 

• Add to Chrome or Firefox web browsers for TTS access to content on the fly 
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This document is meant only as an introduction to the most basic features.  For more detailed information, please visit the  
the Kurzweil Education website www.Kurzweiledu.com, Kurzweil 3000 Help menu, and the web app Help (www.Kurzweil3000.com).   
 
For further information about customized Professional Development, please contact the Customer Success Dept at 800-894-5374. 
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Open Kurzweil 3000 
 

Double Click the Kurzweil 3000 icon on your desktop.  
 
Login (Web License Subscription Only):   
Your username and password is the same for ALL Kurzweil 3000 Subscription components. 
If you are the Kurzweil site administrator – login is emailed to you in your welcome package from Kurzweil’s 
Customer Service team. 
If you are a teacher or student – check with your school/district Kurzweil site administrator to obtain your 
username and password. 
 
 
 
The Kurzweil 3000 Home Tab 
From here you can: 

• Open a file from the Universal Library, your local computer or Google docs 
• Start a new draft document 
• Start a new brainstorm document 
• Start a new outline 
• Scan a new file 
• See the Tip of the Day 
• See a list of the most recent opened doc 

 
Other Quick Access Tabs 

Read – starting point for reading and highlighting a document 
Write – starting point for the writing path 
Scan – starting point for scanning 
 

 
 

Read buttons and Options dropdowns (Audio, Reference, Online) will be constant on all tabs 
    
 
 
 
 
 
Toolbars and Ribbon  
 
Each tab has its own toolbar and ribbon across the top and 
toolbar down the left side.   
The tools will change depending on the tab you are in.  
 
Use the View menu to toggle the toolbars and ribbon on and off.  The next time you 
login, the settings will be remembered. 
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Two Document Types: Text and Image 
 
 
 
Text Document  

• Text information  
• Open an existing text file or create one in Kurzweil 3000 by typing or 

extracting text  
• Students can edit and format content  

 
Text can be selected, font and font size changed, can be edited. 
 
 
 
Image Document 

• Exact image of page (text, pictures, graphics) and underlying text  
• Created by OCR process by scanning or virtual printer 
• Students can’t modify image  

 
Text, images and document is locked. Use Zoom feature to enlarge, Text, 
Sticky or Voice Notes to annotate on document. Importing a PDF file will 
create an image document. 
 

 Text Documents Image Documents 

Description 
and 
File Creation 
 

Created by typing in text, opening an 
existing text or word processing file, 
or extracting text or annotations or 
highlights within a Kurzweil 3000 
image document 

Image documents  are generated by scanning , 
virtual printing or opening a PDF.  These files 
contain two layers:  
The image, which is a picture of the page that 
you see on the screen and includes pictures, 
graphics and text 
The underlying text, which is the set of words 
that Kurzweil 3000 reads. 

Purpose Students can create, edit and format 
text documents for study guides and 
to complete writing assignments. 

Used for print-based materials that need to be 
read aloud; and for curriculum content that 
includes graphics or images that support the 
text. 

Supported Editing 
Features 

Cut/Paste, insert page breaks, Text 
formatting -  font, size, style, line 
spacing, word spacing 

You cannot change the format of the picture 
layer of image documents. You can change the 
underlying reading order and underlying text 
using Zone Editor and Edit Underlying Text. 

Supported Study Skills 
Features 

Highlights, Bookmarks, Voice Notes, 
Footnotes and Bubble Notes. 

Highlights, Bookmarks, Voice Notes, Footnotes, 
Text Notes, Sticky Notes, Fill in the Blanks Bubble 
Notes 
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Access Content  
 
Kurzweil 3000 can open a variety of files and convert them to .kes files. 
 
From your local Computer, the Universal Library, or Google Drive   

• From the Kurzweil 3000 tab choose Open Existing File 
 
 
 

 
 
 
 
The Universal Library (Web License Subscription Only) 
Unlimited cloud storage for your Kurzweil 3000 files in addition to some pre-loaded content:  

• Your Private and Public folders 
• Public folders for the Top Level admin and any teachers or students in 

your team.  Students cannot see other student’s folders. 
• Classic Literature folder (1800+ titles) 
• Help files folder 
• Non-Fiction Bookbag folder containing 15 titles for grades 3 through 8 
• Sample files folder 
• Templates 

Click on your name to select, and click the plus (+) button  
Click on the folder where the file is saved  
Choose the file from the list on the right 

 
From Google Drive 

• You will be asked to sign in to Google Drive via the web 
• Return to K3000 - the Open from Google Drive folder will be displayed, click on My Drive to see files 

 
Bookstores/Online  
You cannot import a Kindle eBook, but can import eBooks from other sources 
Download the book as an ePub or PDF file to your computer 
 
Images of Printed Material - pictures of pages, articles taken with cell phone, iPad, etc. 

• Save (or upload) image to Google Drive or your local computer 
• Open the image using the appropriate button listed above 

 
From Online File Storage - such as Dropbox, OneDrive, Box, etc. 

• Download the file to your computer from the online storage program (such as Dropbox) 
• Use the Open from Local Computer button or the File menu > Open, to locate the file 

 
From a Scanner (connected to your computer)  

• Choose the Scan tab, choose Scanner Setup button to the right of the Zoom 
options and choose your scanner  

• Place the document or page on the scanner, click the Start a Scan button   
 
Virtual Print – bring files from another application into K3000 to save as a .kes file 

• Open a file in its native application 
• File > Print and choose the KESI Virtual Printer 
• The file will appear in K3000 to be read, saved, etc. 
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You’ve Opened it, Now Read it! 
 

Feature Steps 
Read Text Aloud or Silent 
 
 

Place your cursor in the text and click the 
Read button (F3) to start reading. 
The Forward and Backward buttons will skip 
to the previous or next reading unit. 
The Audible Reading button toggles between 
audible and silent reading. 
 

Read button 
 
 

Change the Speaking Voice 
 
 NOTE: For English Language 
Learners and for reading text in 
foreign languages:   
23 voices and 10 languages 
supported! 

• Click the Audio Options dropdown 
• Choose a speaker from the dropdown list 

 
Kurzweil will access any speech engines on your 
computer.  The install includes 20+ High Quality 
voices from Acapela! 

 

Audio Options dropdown 
 

 
 
 

Change the Reading Speed 
(Words per Minute) 
 

• Click Audio Options dropdown 
• Change the WPM (words per minute) 

setting up or down 
Increase: (F11) Decrease: (F12) 

Audio Options dropdown 
               

 
 

Change size of Text 
Increase or decrease the size 
of an image document by 
changing the Zoom value. 
 

• Click the Plus or Minus buttons on your 
Zoom button 

• OR Click the down arrow to select a 
preset zoom value. 
Zoom in:  (F7) Zoom out: (F8) 

Zoom button  
 

 

Change the Reading Mode  • Continuous: continuous reading from 
page to page. 

• Self Paced: pause at the end of each unit.  
• Word by Word: pause at the end of each 

word 
• Click Read button to begin again. 

Audio Options dropdown 
               

 
 

Change the Reading Unit  
 

• Click on Reading Unit button and choose 
the block of text that is highlighted when 
reading. 

Audio Options dropdown 
               

Change the Page 
 

• Click the green LEFT and RIGHT arrows on 
your Page buttons.  
OR  

• Click the box and type the page number 
• Press Return/Enter on your keyboard 

Page buttons 
 
 
Next Page (Ctrl E) 
Previous Page (Ctrl R) 
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Basic Vocabulary Tools 
Feature Steps 
Get Definition of a Word 
 
 

• Place your cursor just before a word or 
double click on a word to select it 

• Click on the Definition button 

Read or Write toolbar:   
Dictionary (Ctrl D) 

 
Find Synonyms of a Word to 
support comprehension or to 
expand word-choices when 
writing.  A Digital Roget’s 
Thesaurus is built in to 
Kurzweil 3000. 
 

• Place your cursor just before a word or 
double click on a word to select it 

• Go to the Reference dropdown and 
choose Synonym 

Reference dropdown: Synonym  (Ctrl Q) 

 
Translate passages of text to 
another language (powered by 
Google Translate). 
 
NOTE: Also great for translating 
documents to share non-legal 
documents with students, 
parents and other members of 
the team.   
NOTE: You must be connected 
to the internet to use this 
feature. 

• Highlight the selection of text you would 
like translated. 

• In the Online dropdown, click the 
Translate button 

• Select the Language From and Language 
To 

• Click Translate 
• Click Read to hear the text 
• OR Click Open in new document to create 

a new document of the translation. 
• Save the new document.  

Online dropdown:  Translate 
 

 
 
* 64 Languages supported 
A powerful tool for English Language 
Learners to translate on the fly and build 
their knowledge of English.   
 
 

Get a Picture of a word using 
the built-in picture dictionary 
including 12,000 Widgit 
Symbols    

• Place your cursor just before a word or 
double click on a word to select it 

• Click on the Picture button 
• Picture will pop up 

Read or Write toolbar:  Get picture of 
selected word 

 
 

 
 
Basic Study Tools  

Feature Steps 
Highlight, Circle or Cross out 
text 
 

• Different colors of highlighters let you 
associate different concepts with 
different colors  

• Choose a highlighter, click and drag 
across text to highlight, circle or cross out 

Read or Write toolbars: Highlighter  
 

 
 
 

 
Erase Highlights or Circles 
 

Highlights and Circles can be erased by 
selecting the Erase tool and dragging your 
mouse over the highlighted or circled text.  

Read or Write toolbars: Highlight Eraser 
 

 
 

Extract Highlights to an 
outline 

Highlights can be extracted to an outline. 
In the dialog box you can customize the 
extraction settings. 

File > Extract > Extract Notes and 
Highlights… 
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Basic Study Tools  

Feature Steps 
Insert a Sticky Note 
 

Sticky Notes can be used to insert 
questions/notes about the text or provide 
instructions.  They are brightly colored and 
standout when reading the text. 
• Click on the Sticky Note button 
• Click anywhere on your open document 
• Begin Typing 

Read or Write toolbar: Sticky Note 

 
 
NOTE: not available in text documents 

 

Insert a Text Note 
 

Text Notes can be used to answer questions 
in a .kes test or quiz file. They have a 
transparent background – great for fill-in-the-
blanks or labeling graphics. 
• Click on the Text Note button 
• Click anywhere on your open document 
• Begin Typing 
 

Read or Write toolbar: Text Note 

 
NOTE: not available in text documents 
 
To quickly insert text notes on every 
blank line on a page: 
Tools > Fill-in-the-blanks 

Insert a Voice Note 
Voice notes are a great way to 
support English Language 
Learners by embedding 
clarifying notes recorded by 
native speakers of the language.  

Voice note tool can be used to insert a 
recording of your own voice. 
• Click on the Voice Note button 
• Click anywhere on your open document 
• A dialog box will open 
• Click on the microphone to record a 

message up to 120 seconds long. 
• Click OK 
• To hear the note: Double click  

Study skills toolbar: Voice button 

 
 
NOTE: Microphone is needed to record 
voice notes. 

Delete a note • Click on the note ONE time 
• Click Delete button  

OR  
• Right Click on a note and select Delete 

note 

Read toolbar: Delete 
 

 

Insert a Bookmark to mark 
important places in the text.  
 

• Click anywhere on your open file. 
• Click on the Bookmark button 
• Type in a description and click Add 
• To view Bookmarks in a document, click 

on the bookmark tool to view them all.  
• Click on the Bookmark you would like to 

Go To. 

Bookmark button 
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Basic Writing Tools 
Feature Steps 
Start Writing 
 

• On the Kurzweil 3000 tab you can choose 
to start a New Draft, New Brainstorm or 
New Outline document 

or 
• Click on the Write tab to begin 
• Click the New Document button 

 

 
 

Listen to my written work 
 

Using Kurzweil 3000’s talking word processor 
to read text out loud can be extremely 
helpful with editing and revising written 
work.  

Read button (F3) 

 

Format the text 
 

Basic tools for style are available: 
• Font  
• Size 
• Style 
• Alignment 

Write toolbar:  Style Tools 

 
Now available:  Open Dyslexic font 

Check Spelling 
 

To check the Spelling of any word you type:  
• Click on the Spell Check button 
• Click on each choice to hear your options 
• Click Change 

Write toolbar:  Spell Check   (Shift F8) 

 

Word Prediction as you type 
 

Word Prediction will guess words as they are 
typed based on frequency and recency.  
• Click on the Word Prediction button 
• Begin typing your draft 
• Words will be offered as you type 
• Click on the Number of the word to insert  

Write toolbar: Word prediction  
(Shift F11) 

 
 

 
 
Don’t Forget to Save! 
You can save files to your local computer, a local network drive, Save a copy to Google Drive, and the Universal Library (Web 
License Subscription Only). 
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Resources 
 
The Kurzweil Academy 
New product features, videos, downloads, strategies and more! 
https://kurzweiledu.com/kurzweil-academy/kurzweil-academy.html 
 
Customized Training 
Customer Success Department 
Call:  1-800-894-5374 x626 
Email:  CustomerSuccess@KurzweilEdu.com  
• Implementation Partnerships for ongoing consultation 
• Live Online Workshops  
• On-site Trainings  
• In-classroom coaching 

 
Live Technical Support 
Technical Support Department:  
Call: 1-800-894-5374, option 3 
Email: Tech@KurzweilEdu.com 
 
Customer Support Portal:   
https://support.cambiumtech.com/index.php 
 
Customer Service email: 
CustomerService@KurzweilEdu.com  
 


